
To Download Images to a Computer for
Windows

for
Macintosh

Install the Software p. 6 p. 62

Connect the Camera to a Computer p. 8 p. 64

Start the Software and Download Images p. 18 p. 68

Start ZoomBrowser EX (Windows) or ImageBrowser (Macintosh computers)
and load images onto the computer. 

• This guide explains the installation method and features of the software for loading
and processing images on a computer that have been shot with a Canon digital camera.

• There are precautions that you should take before installing the USB driver software.
Ensure that you read this guide before installing it.

• Read the agreement in this guide before using the software on the supplied CD-ROM.
By using the software, you agree to be bound by the terms of the agreement.
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READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN
THIS BOX.  BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS
AGREEMENT.

This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE “SOFTWARE”) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and
conditions of this Agreement.

1.  LICENSE:  Canon grants you the non-exclusive right to use the SOFTWARE only on a
single computer.  You may physically transfer the SOFTWARE from one computer to
another provided that the SOFTWARE is used on only one computer at a time.  You
shall not install or use the SOFTWARE on a network, multiple CPU, multiple site
arrangement, or any other hardware configuration where the SOFTWARE is accessible
to more than one CPU or to more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2.  BACK-UP COPY:  You may make one copy of the SOFTWARE solely for back-up
purposes, or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk)
of your computer and retain the original for back-up purposes.  Any other copying of
the SOFTWARE is a violation of this Agreement.  You must reproduce and include the
copyright notice on the back-up copy.

3.  SUPPORT AND UPDATES:  Canon is not responsible for providing maintenance or
support  for use of the SOFTWARE.  No updates, fixes or support will be made available
for the SOFTWARE.

4.  LIMITED WARRANTY AND LIMITATION OF LIABILITY:  It is your responsibility to choose,
maintain and match the hardware and software components of your computer system.
Thus Canon does not guarantee uninterrupted service or correction of errors or that
the functions or performance of the SOFTWARE will meet your requirements.  THE
SOFTWARE IS LICENSED ON AN “AS IS” BASIS AND WITHOUT WARRANTY OF ANY
KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material
under normal use for a period of ninety (90) days after purchase from an authorized
Canon dealer as evidenced by your sales receipt. Your sole remedy for a defective CD-
ROM shall be replacement of the same without charge when returned by you at your
expense to your point of purchase and proven to be defective upon inspection.  The
Replacement CD-ROM will be warranted for the remainder of the original ninety (90)
day warranty period of the defective CD-ROM.  The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the
SOFTWARE and shall not extend to anyone other than the original user of the
SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.
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NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5.  TERM:  This Agreement is effective upon your using the SOFTWARE and remains in
effect until expiration of all copyright interests in the SOFTWARE unless earlier
terminated.  You may terminate this Agreement by destroying the SOFTWARE.  This
Agreement will also terminate without notice to you if you fail to comply with any of
the terms of this Agreement and you must then promptly return the SOFTWARE.  In
addition, Canon may enforce its other legal rights.

6.  U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:  The SOFTWARE is provided with
restricted rights.  Use, duplication or disclosure is subject to restrictions as set forth in
either subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software
clause at DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial
Computer Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7.  SEVERABILITY:  In the event that any provision of this Agreement is declared or found
to be illegal by any court or tribunal of competent jurisdiction, such provision shall be
null and void with respect to the jurisdiction of that court or tribunal and all the
remaining provisions of this Agreement shall remain in full force and effect.

8.  CONTROLLING LAW:  The terms of this Agreement as it relates to purchases of the
Software in the United States of America shall be governed and construed in all
respects in accordance with the laws and regulations of the State of New York, without
reference to choice of law principles.  The terms of this Agreement as it relates to
purchases of the Software in Canada shall be governed by the laws of the province of
Ontario.

9.  OWNERSHIP:  All rights, including but not limited to copyrights and trade secret rights,
to the SOFTWARE belong to Canon, its affiliated corporations and third party licensors.
Your use of the SOFTWARE is subject to the United States, Canada and other applicable
copyright and trademark laws and nothing in this Agreement constitutes a waiver of
the rights of Canon, its affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership
rights in any images, graphics or textual material that you save in connection with the
Software.

10.  ACKNOWLEDGEMENT:  BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS.  YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR
PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF.  NO AMENDMENT
TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED
OFFICER OF CANON.
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Introduction
Thank you for purchasing a Canon digital camera. This guide explains the software used
with the EOS D30.

Note
• This software can also be used with most other Canon digital cameras including

the PowerShot series.
Please refer to the chart on Page 4 for Windows or Page 60 for Macintosh
computers for further information.

Safety Precautions

Please read the safety precautions carefully before using this product. Ensure that you use
the product correctly according to the procedures described in this guide.

The following safety precautions are intended to instruct you in the safe and correct
operation of the product and its accessories to prevent injuries or damage to yourself,
other persons and property. Please read and ensure that you understand them before you
proceed to the other sections of this guide.

Warnings This mark indicates topics that could lead to death or serious injury if
ignored or handled incorrectly.

  Warning

• Do not play the supplied CD-ROM(s) in any CD-ROM Player that does not support
data CD-ROMs. The extremely loud sound that may result from playing the CD-
ROM(s) in an audio CD player (music player) could damage the speakers. It is also
possible to suffer hearing losses from listening with headphones to the loud
sounds of a data CD-ROM played on a music CD player.
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Introducing the Software
This section introduces the powerful software programs for the Windows platform
contained on the CD-ROMs (2) included with the camera.

  Canon Digital Camera Solution Disk

ZoomBrowser EX

To load camera images, start ZoomBrowser EX.

Camera Connection Functions
(Also effective for CF card readers or PC card readers)

• Displays camera images.
• Downloads camera images to the computer.
• Loads and saves RAW images in the RAW format.
• Converts and saves RAW images in other formats.
• Saves computer images to a CF card in the camera.
• Connecting to a USB port automatically starts ZoomBrowser EX and displays the

camera images.
• Sets the camera parameters.

Image File Management Functions

• Displays, moves, copies or deletes images stored on computer disks.
• Allows simple editing procedures, such as image color adjustments and cropping.
• Displays all the files in a specified folder at once and zooms them in and out to

facilitate visual searches.
• Displays files in chronological order in a window that looks like a time tunnel.
• Replays images from the computer one-by-one at full screen size to simulate a

slide show.

Image Printing Functions

• Prints multiple images on the same page using the PhotoRecord printing utility.
• Performs auto layouts.
• Allows you to effortlessly place frames or backgrounds around your images for

artistic effect.
• Allows you to place titles or captions anywhere on the page.
• Lets you create your own exclusive albums.

Supports PhotoStitch Panoramas

• Allows you to select camera images or images registered with ZoomBrowser EX and
start PhotoStitch from within ZoomBrowser EX to merge a series of images into a
panorama in a few simple steps.
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Supports the Adobe Photoshop LE Photo Retouching Program

• This photo-retouching program can be used to edit and apply special effects to your
images if it is installed and started.

Starts Your E-mail Program

• Starts your e-mail program and prepares images as e-mail attachments.
• Allows you to adjust image size and compression settings so that large files can be

made smaller for transmission.

PhotoStitch
• Effortlessly merges images that are shot over several frames with a camera.
• Merges any number of images horizontally or vertically, or in a matrix format.
• Makes images with straight lines appear natural not crooked when merged. (Select

the wide display format.)
• A 360-degree scene shot in several frames can be merged into a 360-degree image

and saved in the QuickTime VR format, making it appear as if you were standing in
the middle of the image looking about in all directions.

RemoteCapture
• Connecting via a USB port allows you to release the EOS D30’s shutter button from

the computer. The images are loaded directly into the computer.
• Connecting via a USB port also allows you to load images directly into the computer

by clicking the camera’s shutter button.
• Allows interval shooting with custom interval and frame settings.

TWAIN Drivers
Canon Digital Camera USB TWAIN Driver
Canon Digital Camera RS-232C TWAIN Driver

These are the driver utility programs that work within TWAIN-compliant application
programs, such as Adobe Photoshop, to load camera images directly into the
application program. The USB TWAIN Driver is for connecting via a USB port. The RS-
232C TWAIN Driver is for connecting via a serial (COM) port. Install the RS-232C
TWAIN Driver if you are going to load images via a CF card reader or PC card reader
in Windows 95/Windows NT 4.0. Start either TWAIN driver from a TWAIN-compliant
application program. Neither TWAIN driver can be used as a stand-alone program.

   Adobe Photoshop LE CD-ROM

Adobe Photoshop LE
• Allows you to edit images, apply special effects, print and create sophisticated

graphics for the web.
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Camera and Software Compatibility
The Canon Digital Camera Solution Disk contains a number of software programs and
drivers. Check the chart below for the compatibility of your particular camera model with
each program’s special functions.

*1  Only compatible with computers with built-in USB ports running pre-installed versions of Windows 98 or Windows 2000.

*2  Only compatible with the USB interface.
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Downloading 
From External
Card Reader

RAW Image 
Conversion

Uploading 
to Camera

Shooting from 
the Computer

Editing Camera 
Print Settings 
(DPOF)
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EOS D30 DIGITAL
IXUS S100 S10/S20 A50

Pro70
A5 Zoom

A5
350 600



5

W
in

d
o

w
s

System Requirements
The following system requirements must be met to install and operate the software.

=Computer Model
IBM PC/AT compatible

=OS
Windows 95, Windows 98 (Including the Second Edition),
Windows NT 4.0 (Service Pack 3 or higher required) or
Windows 2000

=CPU
Pentium 133 MHz or better

=RAM
32 MB or more (Windows 95/98)
64 MB or more (Windows NT 4.0/Windows 2000)

= Interface
USB: (Limited to pre-installed Windows 98 or

Windows 2000 systems)

= Free Hard Disk Space
Canon Utilities
     ZoomBrowser EX: 120 MB or more

     (Including the PhotoRecord printing utility)
     PhotoStitch: 40 MB or more
     RemoteCapture: 20 MB or more
Canon Digital Camera USB TWAIN Driver: 15 MB or more
Canon Digital Camera RS-232C TWAIN Driver:

15 MB or more
Adobe Photoshop LE: 40 MB or more

=Display
Minimum:          800 x 600 pixels, 256 colors (8 bit)
Recommended: 1,024 x 768 pixels, High Color (16 bit) or

more

• The cable connection is only supported for computers with Windows 98 or
Windows 2000 preinstalled.

• A CD-ROM drive is required to install the software.
• QuickTime 3 or higher is required to save PhotoStitch output in the QuickTime VR

format.
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Installing/Uninstalling the Software
Installing from the Canon Digital Camera Solution Disk

If you are installing the software onto Windows NT 4.0 or Windows 2000, you must
first log on as the administrator and then install the software.

1. Close any programs that are running.

2. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.
The installer panel will automatically display.

• If the installer panel does not automatically display, use the following procedures
to start it.
1. Double-click the [My Computer] icon on the desktop, and double-click the

CD-ROM icon in the next window.
2. Double-click the [Setup] icon.

3. Click [Software Installation].

4. Select the install location and click the [Next] button.

5. Select the software you wish to install and follow the on-screen
instructions to proceed.

6. Click the [Exit] button when the installation is complete and the installer
panel appears again.
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Installing from the Adobe Photoshop LE CD-ROM
Place the Adobe Photoshop LE CD-ROM in the drive and double-click the [My Computer],
[Photosle], [English], and [Photosle] folders, followed by the [Setup.exe] file. Follow the
on-screen instructions to continue with the installation.

You must input the software serial number to install Adobe Photoshop LE.
It can be found on the CD-ROM case.

If You Will Be Connecting via a USB Port
You must install a separate USB driver. Please see page 11 or 14 for instructions.

Uninstalling the Software
To remove the installed software, click the Windows [Start] menu and select [Settings],
[Control Panel] and [Add/Remove Programs]. ZoomBrowser EX can also be uninstalled by
clicking the [Start] menu and selecting [Programs], [Canon Utilities], [ZoomBrowser EX],
and [ZoomBrowser EX Uninstall]. (PhotoRecord, PhotoStitch and RemoteCapture can be
removed with the same procedures.)

To remove Adobe Photoshop LE, click the Windows [Start] menu and select [Programs],
[Adobe], [Photoshop Limited Edition] and [Uninstall Photoshop Limited Edition].
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Connecting the Camera to a Computer
Selecting a Connection Method
The following different interfaces and methods can be used to connect the camera to a
computer. Once a connection has been established using one of the methods, you can
start the software and begin to load images from the camera (➜ p. 18, 42).

Use the AC Adapter
• We suggest that you use the AC adapter while the camera is connected to a

computer to conserve battery power.

USB Port (➜ p. 9)

The USB interface can start the image loading software automatically.

CF Card Reader or PC Card Slot  (➜ p. 17)

If you have a computer equipped with a PC card slot, a CF card reader or a PC card
reader, you can place the camera’s CF card into these devices to establish a direct
connection. You will require a PC card adapter for PC card slots.

CF Card

USB Cable Connector Shapes

Computer EndCamera End

Computer USB Port

The USB port is
marked with
this symbol.

PC Card Adapter



9

W
in

d
o

w
s

Connecting to a USB Port

Requirements for the USB Interface
• The USB interface can only be used to connect the camera to computers with

Windows 98 or Windows 2000 preinstalled. The USB ports on computers
running versions of Windows 98 or Windows 2000 upgraded from Windows 3.1
or Windows 95, or versions of Windows 2000 upgraded from Windows 98 may
not operate correctly.

• Connect the USB cable directly to one of the computer’s main USB ports. The
interface may not function correctly if the camera is connected via a USB hub.

• The interface may not function correctly while other USB devices, excluding USB
mice and keyboards, are connected. If this problem arises, detach the camera
and the other devices, and reconnect the camera only.

• Do not attach more than one camera to the USB ports of the same computer at
the same time. The cameras may not operate correctly.

Important
• Please do not place your computer into standby mode while the camera is

connected to its USB port. If you place the computer into standby mode while
the camera is connected to a USB port, do NOT disconnect the USB cable from
the camera or computer. Try to revive the computer. If the USB cable is detached
in standby mode, some computers may not return to active mode correctly. For
instructions regarding the standby mode, please consult the manual
accompanying your computer and operating software.
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1. Attach the supplied USB cable to a USB port directly on the computer
and to the DIGITAL terminal on the camera as shown below.
• There is no need to turn the camera or computer power off when attaching or

detaching the USB cables.

• Please consult your computer’s manual for the location of the USB ports.

2. Install the USB driver the first time you connect via a USB port.
(➜ p. 11, 14)

Precaution for Unplugging Cables
from the DIGITAL Terminal
• Always press the PUSH button on the

connector to detach the cable from the camera’s
DIGITAL terminal.

USB Port

USB Connector

PUSH Button

DIGITAL Terminal

USB Connector

2. Insert the connector so that the4 marks on
the connector and camera align.

1. Open the expansion
electronics cover.
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Installing the USB Driver
(Preinstalled Windows 98/2000 Systems Only)

Notes Regarding Installation
• The USB driver only needs to be installed the first time the camera is connected via the

USB interface. Installation is not required from the second time onward.

• Do not cancel the installation partway through. Allow the procedure to finish completely
before exiting. The camera may not operate correctly if the installation is incomplete.

• Read the “Troubleshooting the USB Driver Installation” section on page 49 if the
installation cancels itself during the procedure, if the installation does not proceed as
described in these procedures, or if you think that the drivers are not properly installed.

• Read the “Uninstalling the USB Driver” section on page 49 or 52 for instructions for that
procedure.

Installing the USB Driver into Windows 98

Windows 98 CD-ROM
• Your computer may prompt you to insert the CD-ROM containing your Windows

system software during the installation. Have the Windows disk handy in case it is
required.

1. Once you have attached the USB cable to the camera and computer, set
the camera’s main switch to [On]. (➜ p. 10)
The “Add New Hardware Wizard” dialog will appear after a moment.

2. Read the dialog and click the [Next] button.

The dialog will change to the search selection dialog.

Your camera model name
will appear here.



12

3. Select [Search for the best driver for your device (recommended)] and
click the [Next] button.

The dialog will change to the one that allows you to specify the search location.

4. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.

5. Place a check in the [Specify a location] option, click the [Browse]
button, and select the [\USB_drv\English] folder. Click the [Next] button.

The dialog will change to the one that states it is searching for the driver files.

6. Read the dialog and click the [Next] button.

Your camera model name
will appear here.
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The computer will start to copy the driver files from the CD-ROM.

When all the required files have been copied, the dialog will state that the
installation is complete.

What to Do if You Are Prompted for the Windows System Disk
during the Driver File Copying Process
• If prompted for the Windows system disk, replace the Canon Digital Camera

Solution Disk with it and follow the on-screen instructions. If a dialog states that
the “usbscan.sys” cannot be found, click the [Browse] button and specify the
location as the [WIN98] folder on the Windows system disk.

7. Read the dialog and click the [Finish] button.

An event dialog for your camera model will display to allow you to select
application programs. (➜ p. 18, Step 3, or p. 42, Step 3.)
• If a dialog prompts you to restart your computer, remove the CD-ROM from the

drive and restart the computer as instructed.

Do NOT cancel the copy
operation while it is in progress.

Your camera model name
will appear here.
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Installing the USB Driver into Windows 2000

Begin by logging onto the computer as an Administrator and then install the USB
driver.

1. Once you have attached the USB cable to the camera and computer, set
the camera’s main switch to [On]. (➜ p. 10)
The “Found New Hardware Wizard” dialog will appear after a moment.

2. Read the dialog and click the [Next] button.

3. Select [Search for a suitable driver for my device (recommended)] and
click the [Next] button.

The dialog will change to the one that allows you to specify the search location.

4. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.

Your camera model
name will appear
here.
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5.  Place a check in the [Specify a location] option, click the [Next] button.

The dialog will change to the one that states it is searching for the driver files.

6. Click the [Browse] button, select the [\USB_drv\English] folder from the
Solution Disk and click [OK].

7. Read the dialog and click the [Next] button.

Your camera model
name will appear
here.

Your camera model
name will appear
here.
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8. Click the [Yes] button if the “Digital Signature Not Found” message
displays.

9. Click [No to All] if the “Confirm File Replace” dialog displays.

10. Read the message and click the [Finish] button.

An event dialog for your camera model will display to allow you to select application
programs. (➜ p. 18, Step 3 or p. 42, Step 3.)
• If a dialog prompts you to restart your computer, remove the CD-ROM from the

drive and restart the computer as instructed.

Your camera model
name will appear
here.

Your camera model
name will appear
here.
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Connecting via a CF Card Reader or PC Card Slot
To load images directly from a CF card to a computer, eject the card from the camera,
place it in a separately sold PCMCIA card adapter (PC card adapter) and insert the
assembly into the PC card slot.

The adapter is not required if your computer is equipped with a CF card reader. Place the
CF card directly into the reader.

1. Place the CF card in the PC card adapter.

2. Insert the loaded PC card adapter into the computer’s slot or PC card
reader.
The requirements for the power being on or off when the PC card adapter is
inserted differ according to the product. Please consult the manuals accompanying
your equipment.

Insert the Adapter in the Slot.

Place the CF Card in the Adapter.
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Using ZoomBrowser EX the First Time
   (From Loading to Printing)
This section provides a simple explanation of the procedures for using ZoomBrowser EX to
perform each of the steps from loading to printing. Please refer to the ZoomBrowser EX
Help file for more details.

What to Do if the “Caution! Connection Time” Dialog Displays
• If a set period of time passes without a camera function being accessed when

the camera is connected via the USB interface, a message on the computer
display will ask if you wish to remain connected. If you do not access a
function, the camera will close the connection after an additional minute
passes. The time required for the message to display will vary with the camera’s
auto power off setting. Please see the Camera User’s Guide for details. (The
message will not display and the camera will not disconnect if an AC adapter
is used or auto power off is turned off.)

• To reconnect the camera, press the camera’s shutter button.

Starting ZoomBrowser EX
USB Interface

1. Attach the camera to the computer with the USB cable. (➜ p. 10)

2. Set the camera’s main switch to [On].
After a moment, an event dialog will allow you to select an application program
to start.

3. Select [Canon ZoomBrowser EX] and click the [OK] button.
ZoomBrowser EX will start and display the camera’s images as small thumbnail
images in the ZoomBrowser EX Camera Window. (➜ p. 20)
Quick Tips will automatically display. Read these tips to quickly gain an
understanding of the operating procedures.

Your camera model name
will appear here.
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How to Have ZoomBrowser EX Start Automatically
• If you want ZoomBrowser EX to start automatically without first displaying the event

dialog, use the procedures below to change the settings.
1. Open the [My Computer] window while the camera is connected to the

computer via the USB interface.
2. Open the [Control Panel] and select [Scanners and Cameras] and your camera

model.
3. Click the [Properties] button and display the [Events] tab.
4. A list of applications registered for automatic starting will display. Remove the

checks beside every program except for ZoomBrowser EX. Click the [OK] button.
• ZoomBrowser EX will now start automatically the next time you connect the camera.

If the [Disable device events] option has a check mark, the automatic start will be
turned off.

CF Card Reader or PC Card Slot Interface

1. Place the CF card into the CF card reader or into the PC card adapter and
then into the PC card slot. (➜ p. 17)

2. Start ZoomBrowser EX.
Double-click the [Canon ZoomBrowser EX] icon on the desktop to start the program.

If the [Canon ZoomBrowser EX] icon does not appear on the desktop, click the
Windows [Start] button and select [Programs], [Canon Utilities], [ZoomBrowser EX]
and [ZoomBrowser EX].

Quick Tips will automatically display. Read these tips to quickly understand
operating procedures.

3. Click the [IMPORT IMAGES] button and select [From Dcim].
The images from the CF card will display in ZoomBrowser EX Camera Window as
small thumbnail images. (➜ p. 20)

Canon ZoomBrowser EX Icon
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The ZoomBrowser EX Camera Window
The Camera Window will open when a connection to a camera or CF card is initiated.
Thumbnail (small) images will display.

SETUP OPTIONS Button
Sets various camera
settings (see inset below)
using the computer.

How to Check and Change Various Camera Settings
• You can adjust the date, time and owner settings in the Camera Settings dialog

using the computer when the camera is connected. You can also check the battery
charge and remaining memory capacity.
1. Click the [SETUP OPTIONS] button.
2. Check or change the settings.

An image of the connected
camera or CF card will display.

Thumbnail

UPLOAD Button
Copies images from the computer
to the camera or CF card. (➜ p. 30)

DELETE Button
Deletes the
selected
images.

DOWNLOAD Button
Copies selected images to the computer
from the camera or CF card. (➜ p. 21)

Input a camera owner name here. (up
to 31 characters)

Set the date and time.

Click this button to synchronize the
camera to the computer’s date and
time settings.

Check the battery charge here.

Formats the CF card in the camera.

Check the remaining memory capacity
here.

Sets the camera parameters. (➜ p. 45)
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Loading and Saving Images from the Camera

1. Create a new folder in which to save the images from the camera.
In the Tree View, right-click the [Image Library One] folder, select [New Folder] from
the pop-up menu and input a folder name.

2. Select the new folder in the Tree View.

3. Select the images that you wish to download from the Camera Window
and click the [DOWNLOAD] button.
Click the thumbnail you wish to select or press [Ctrl] and click to select multiple
thumbnails.

The downloaded images will be saved to the computer disk and appear in the
Browser Display Area.

Tree View

Thumbnail
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• You can also download images to the computer by dragging them from the
Camera Window and dropping them on the Browser Display Area or Tree View.

To disconnect the camera, click the close box  at the upper right of the Camera
Window. The Camera Window will close.

Tree View

Browser Display Area
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Printing Images

1. Select the image(s) you wish to print and click the [PRINT LAYOUT] button.

The PhotoRecord printing utility will start and automatically display the selected
image(s) in a page layout.

2. Adjust the print settings if you wish to change the page layout.
Please refer to page 33 or the PhotoRecord Help file for details of the settings.

3. Click the PhotoRecord [PRINT] button.

The Print dialog will display.

4. Click the [OK] button to start printing.
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Using Additional ZoomBrowser EX Functions
This section explains the additional features of ZoomBrowser EX. Please refer to the
ZoomBrowser EX Help file for more details.

Displaying Images
Zooming Images In and Out

(a) Double-Clicking the Browser Display Area
Double-click the background frame of the folder in which an image is registered to
zoom it to fill the Browser Display Area.

(b) Selecting a Folder in the Tree View
You can also zoom a folder in or out with its icon selected in the Tree View.

Browser Display Area

Click this button to go back to
a folder one level higher.

Click a higher level folder to zoom out.

Click a lower level folder to zoom in.

Double-click the
background frame
of the folder.
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Zooming a Single Image

Double-click an image in the Browser Display Area to display it in the Image Viewer.

Double-click the target image.
Edit Panel Button

About the Image Viewer Edit Panel
• The edit panel displays when you click Edit Panel button in the Image Viewer.

CROP Button
Drag the cursor to
select the crop area
and click the [CROP]
button to trim
everything outside the
crop area.

UNDO/REDO Buttons
Reverse an action or reimplement it.

COLOR/BRIGHTNESS/CONTRAST Sliders
Slide the tab to adjust the color,
brightness or contrast settings.SAVE AS Button

Save the image with
a different name and
file format.
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Displaying Images in Chronological Order

Select a folder or some images, click the [View] menu and select [TimeTunnel]. The
selected image(s) will display in a time tunnel. Please refer to the TimeTunnel Help file
for more details on how to operate this function.

Showing Images in a Slide Show

The slide show function displays images saved onto the computer disk one-by-one at
full-screen size as if they were part of a slide show.

1. Click the [View] menu and select [Slide Show Options].

2. Select a play method.
The “Slide Show Options” dialog will display.
Set a play interval and a transition effect and click the [OK] button.

3. Select images from the ZoomBrowser EX Browser Display Area for showing.

4. Click the [View] menu and select [Slide Show].
The selected images will play in order. The slide show will close after the last image
is displayed. If the slide show is set to repeat, press the  on the control panel to
close the slide show.

Drag the tab up or down to go
backward or forward in time.
The time tunnel will advance in
the selected direction.

To quit TimeTunnel and return to
the ZoomBrowser EX window,
click this button.
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About the Print Mark Button
• If the [Print Mark] button is clicked while an image is played in a slide show,

PhotoRecord will automatically start after slide show has finished and place the
displayed image with a print mark in an auto layout.

• Please refer to page 33 or the PhotoRecord Help file for more details on how to
operate this function.

Print Mark Button
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Organizing Images
Changing the File Location

You can move an image file by dragging and dropping it onto another folder icon.

The [Image Library One] folder is located within the folder in which ZoomBrowser EX
was installed. The Tree View displays files at levels below this folder.

Adding a New Library Folder

Adding a folder to the Tree View allows you to display the images in that folder and its
subfolders in ZoomBrowser EX. Click the [File] menu, select [Add Image Library] and
select the folder. The selected folder will appear in the ZoomBrowser EX Tree View as a
new library.

Refreshing the Contents of a Library

If you have used another program, such as the Windows Explorer utility or Adobe
Photoshop LE, to move or edit images registered with ZoomBrowser EX, you should
select the library, click the [View] menu and select [Refresh Current Library]. This will
update the library.

Drag an image from the Browser Display Area
to another folder in the Tree View.

Browser Display Area

You can also drag
and drop images
within the Browser
Display Area.

Tree View
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Erasing Images

An image cannot be recovered after it is erased. Double-check to make sure you
have the right images before erasing.

Erasing Images Singly

1. Select the target image in the Browser Display Area and click the [DELETE]
button.
A confirmation dialog will display.

2. Check the image to make sure it can be deleted and click [Delete].
The image will be erased.

Erasing Images by Folder

1. Click the background frame of the target folder and the [DELETE] button.
A confirmation dialog will display.

2. Check the images to make sure they can be deleted and click [Delete].
The images and the folder will be erased.

Tree View DELETE Button

Click images
singly to
erase them.

Click on the
folder’s
background
frame to erase
the folder and
all its images.

Browser
Display Area
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Saving Computer Images to a CF Card in the Camera

1. Open the Camera Window. (➜ pp. 18-20)

2. Click the [UPLOAD] button in the Camera Window.
The “Upload Images from Disk” dialog will display.

3. Select the images from the computer and click the [Open] button.
The “Save to Camera” dialog will display.

4. Select the image size and resizing options and click the [Save to Camera]
button.
The selected image will be saved onto the camera’s CF card.

Follow the instructions
to merge the images.

Merging Panoramic Images with PhotoStitch
To Merge Images Registered in ZoomBrowser EX

• You can merge a series of overlapping images into a single, seamless panorama.

• Select the images in the browser area, click the [Edit] menu and select [PhotoStitch].
The PhotoStitch program will start.

• Follow the instructions in the guidance window to merge the images.
• Please refer to the PhotoStitch Help file for more details.
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Sending Images via E-mail
You can send images as attachments to e-mail messages. You can adjust the image size
and quality to reduce the file size for transmission.

1. Select the target image(s) in the Browser Display Area.

2. Click the [File] menu and select [Send Image(s) by E-Mail].

3. Adjust the image size and quality.
The e-mail image creation window will display.

Set the image size and quality and follow the on-screen messages to complete the
procedures.

4. Click the [Finish] button.
When you click the [Finish] button, your e-mail program will start and open a new
message with the image file attached. Input your message, a subject, the recipient’s
address and send the message.

Some e-mail programs or operating systems may not support the auto start
function. In that case, temporarily save the adjusted image file to the desktop or
another easy-to-find folder. Then start your e-mail program, open a new message
and attach the adjusted image file to it.

Editing and Applying Special Effects to Images

1. Confirm that Adobe Photoshop LE has been installed.

2. Select an image from the Browser Display Area of ZoomBrowser EX.

3. Click the [Edit] menu and select [Edit Image using Adobe Photoshop].
Please refer to the Adobe Photoshop LE Help file and electronic guide
(User Guide.pdf) for instructions for this program.

4. Edit and apply special effects to the image.
• ZoomBrowser EX supports the BMP, FlashPix, JPEG and TIFF file formats.

• If you selected a folder registered in ZoomBrowser EX as the save location, please
return to the ZoomBrowser EX window, click the [View] menu and select [Refresh
Current Library] to update the thumbnail in ZoomBrowser EX.
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Editing the Print Order Settings (DPOF)
You can specify which images on a CF card you wish to print as well as the number of
copies. You can also select the print type and whether or not the shooting date and file
number information is printed with the image. A convenient feature of these settings is
that they comply with the DPOF (Digital Print Order Format) standards, which allow you
to print on any DPOF-compliant digital printer or order prints from a participating photo
developing laboratory.

1. Open the Camera Window. (➜ pp. 18-20)

2. Click the [Slide/DPOF] button.
The Edit Slide/DPOF window will display.

3. Click [Print Order (DPOF)] at the window's upper left.

4. Select the print type from among the [Standard Print], [Index Print] or
[Both] options.
• Standard .. Set the number of copies of the images you wish to print in the

column below the thumbnails.
• Index ....... A check mark will appear below the thumbnails selected for printing.

5. Click the [Save to Camera] button.
The print order settings will be saved to the CF card in the camera.

6. Click the [Exit] button.

• A warning message will display if ZoomBrowser EX encounters print settings data
it does not support on a CF card with print settings created by a non-Canon brand
DPOF-compliant digital camera. If any print settings on such a card are changed, all
of them will be overwritten by ZoomBrowser EX and lost.

• Some printers or photo developing laboratories may not be able to reflect all of the
print settings in the output.
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Printing Images
• Select a folder or image(s) for printing from the Browser Display Area or Camera

Window and click the [PRINT LAYOUT] button to start the PhotoRecord program.

• You can also click the  button while an image is displayed in a slide show to add a
print mark to it. When the slide show closes, PhotoRecord will start automatically.

• The selected images will automatically display in a page layout.

• Please refer to the PhotoRecord Help file for more details.

PhotoRecord Window

Drag the images to
change the layout.

Slide this tab to the left
to shrink the image,
right to expand it.

Click this to display
Help.

Click this to switch
between auto and
manual layout mode.

Click this to stop
importing images.

Click these buttons
to select a layout
pattern for each
page.

Click this to display
the Print dialog.

Click this to set the
album type, paper
size and orientation.

Click this to import images.

Click this to change the background design.

Switch between
control panel sizes
with this.

Click these buttons to
undo or restore the
previous action.

Input titles or captions
anywhere you wish.

Click the arrow 6
to display a pop-up
menu.



34

Image Resizing Mode Image Rotating Mode

Drag an arrow to
resize the image.

The arrows display
when the mouse is
positioned over
the image.

Click this to change to
rotating mode.

Click this
to display
a pop-up
menu.

Drag an arrow to
rotate the image.

Click this to change
to image resizing
mode.

Click this
to display
a pop-up
menu.

Creating a New Album

The PhotoRecord layouts with titles and captions can be saved as albums. Moreover,
PhotoRecord includes a variety of templates, making it easy to create beautiful albums.

1. To save an album, click the PhotoRecord [File] menu and select [Save As].

2. Input a name and click [Save].

Image Resizing and Rotating Modes

Add a title to the page
Click the arrow6and select
[Edit Title] from the pop-up
menu.

Add a caption to an image
Right-click an image and select [Edit
Caption] from the pop-up menu.

Change the text box format
Right-click a text box and
select [Change Frame] from
the pop-up menu.

Insert text
Click the arrow6and select [Add Text]
from the pop-up menu.

Change the page background
Right-click the page and select
[Change Page Artwork] from
the pop-up menu.

Change the photo frame
Right-click the image and
select [Change Photo Frame]
from the pop-up menu.
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Setting the Image Size for Printing

Fixed Photo Sizes
Images can be printed at standard photo print sizes.
Since the images are printed without gaps between them, they look like photo prints
when they are cut with a cutter.

1. Click the [Album Settings] button in the PhotoRecord window.
The Album Settings dialog will display.

2. In the [Album Type] category, select [Fixed photo size printing].

3. Set the photo size and click [OK].

Printing on Canon Perforated Paper
The [Canon Perforated paper printing] option will be selectable in the Album Settings
dialog if you are using a Canon BJ printer that supports Canon Perforated Paper media.
Canon Perforated Paper has perforations at the preset dimensions allowing you to print
at the specified size and simply tear along the perforated lines to produce an image with
the appearance of a finished photo print. Please consult the BJ Solutions Disk operating
guide for your printer for more details.

Precaution when Printing from PhotoRecord from
Windows NT 4.0/Windows 2000
• If the printer name is too long, you may not be able to print from PhotoRecord.

Shorten the name to enable printing.

1. Click the Windows [Start] menu and select [Settings] and [Printers].
2. Click the printer name twice with a slight pause between clicks. Input a new

name that is 31 characters or less. If the printer is a network printer, include the
path name in the 31-character count.
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Shooting with the RemoteCapture Function
The RemoteCapture program will start if you click the ZoomBrowser EX [Edit] menu and
select [RemoteCapture]. RemoteCapture lets you activate the camera’s shutter button
remotely from the computer. The captured image is automatically saved into the
ZoomBrowser EX folder that is currently selected.

RemoteCapture Window
Thumbnail View
Displays thumbnails of all the images shot
in the current session since RemoteCapture
was started.

Number of Frames that Can Be Captured
Displays the number of images that can be
saved to the computer or the camera’s CF
card.

Displays the location in
which files are saved.
 (➜ p. 38)

How to Start RemoteCapture Instead of Displaying the
Camera Window
The settings can be changed so that ZoomBrowser EX automatically starts
RemoteCapture instead of its Camera Window when the camera is connected
to the computer’s USB port.

(1) Click the ZoomBrowser EX [File] menu and select [Preferences].
(2) In the Preferences dialog, click the [AutoStart] tab and set [Automatic Start

Options] to [RemoteCapture].
The RemoteCapture window will now show instead of the ZoomBrowser EX
Camera Window when the camera is connected to the USB port and starts
ZoomBrowser EX.

Control Buttons
These buttons control the
basic RemoteCapture
functions. (➜ p. 37)

Displays the image information.

Allows you to add comments to images.
Image View
Displays the image selected in
the Thumbnail View.

Displays the distribution
of brightness data.
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About the RemoteCapture Control Buttons
The control buttons are used to shoot, delete and display images.

Using Interval and Timer Shooting

RemoteCapture can be used to shoot a set number of images at specified intervals
(Interval Shooting) or to shoot an image after a specified delay (Timer Shooting).

Interval Shooting
You can set the number of frames and the interval at which they are shot.

1. Click the [File] menu and select [Interval Shooting].
The Interval Shooting dialog will display.

2. Set the number of frames and interval value and click [OK].
RemoteCapture will start interval shooting, capturing the specified number of
images at the specified intervals.

Timer Shooting
You can set the time delay before an image is shot.

1. Click the [File] menu and select [Timer Shooting].
The Timer Shooting dialog will display.

2. Set the number of seconds and click [OK].
RemoteCapture will start timer shooting, capturing an image after the specified
delay.

Printing a Thumbnail Index Sheet

Thumbnails you select in the Thumbnail View can be printed in order on a single index
sheet by clicking the [File] menu and selecting [Print Index]. Since the file name and
shooting date and time can be printed with each image, index sheets serve as a
convenient record of and reference for your images.

Click here to trigger the camera and take a shot. The
image is automatically saved to the camputer. Pushing the
camera’s shutter button directly will also save the image to
the computer.

Rotates the image saved to the computer by 90 degrees either way.
Select one of these to automatically rotate and save images shot
with the camera swiveled from a horizontal to a vertical orientation.

Displays the image selected in the Thumbnail View in the Viewer.

Deletes the image selected in the Thumbnail View. Please take
proper caution before deleting because deleted images are
completely erased from the computer in one step with this button.
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Precautions when Shooting with RemoteCapture
• The camera’s shooting settings cannot be set from RemoteCapture. They must be

set on the camera.

• If your computer is set to go into standby mode, there is no guarantee that
RemoteCapture will continue to function after the computer has entered standby
mode. Always turn off the standby function before you start shooting with
RemoteCapture.

• If the camera is set for “mirror lockup” shooting, the shutter will activate
approximately two seconds after the release button is clicked in RemoteCapture.

• The camera’s auto power save setting is disabled while connected to
RemoteCapture, and the power remains on until manually turned off. You are
recommended to power the camera with a household power source while it is
connected.

• Please note that the camera will not be able to shoot at the specified interval if it is
shorter than the time required to send the image and save it on the computer.

Changing the Save Location and Other Preferences

The Preferences dialog can be opened by clicking the RemoteCapture [File] menu
and selecting [Preferences]. This dialog can be used to change the save location
and settings.

Selects whether the image is saved only on
the computer or on the camera’s CF card too.

Sets the image file prefix. If the prefix is set
to [Capture], for example, the first image will
be named [Capture_00001.jpg] and
successive images will have higher numbers.

Sets the folder in which the image file is
saved.

Selects a drive on the computer.
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Converting RAW Images
Images shot in the RAW format (hereafter RAW images) are recorded without the image
quality being reduced by signal processing or lossy compression. Please refer to your
Camera User’s Guide to learn how to set the camera to shoot in the RAW format.

High-quality RGB images can be obtained from RAW image file data. When a RAW
image is converted, you can also choose to adjust its quality settings to obtain an image
of a higher caliber than if it had first been loaded into image editing software.

Please note that ZoomBrowser EX or the TWAIN Driver are required to load RAW images
onto a computer.

Please see page 48 for further information about the RAW image format.

Converting RAW Images without Adjusting the Quality

1. Select a RAW image from the Browser Display Area of ZoomBrowser EX.

2. Click the [File] menu and select [Convert RAW Images].
The image is converted and saved in a new TIFF (8 bits/channel) file. To learn
how to change the file format, please see “How to Change the File Format” on
the next page.

Converting RAW Images with Quality Adjustment

1. Select a RAW image from the Browser Display Area of ZoomBrowser EX.

2. Click the [File] menu and select and [Convert RAW Images with User
Defined Parameters].
The RAW Image Parameter Settings dialog will display.

3. Select the quality settings and click [OK].
The RAW image is converted according to the specified parameters and saved
in a new TIFF (8 bits/channel) file. If multiple RAW images are selected, the
parameters are applied only to the first image. When only one RAW image is
adjusted, the changes are also reflected in the remaining images in the
selection. To learn how  to change the file format, please see “How to Change
the File Format” on the next page.
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RAW Image Parameter Settings Dialog

Click this and a white point of
the image in the Preview Area to
set it as the value for the white
balance.

How to Change the File Format
1. Click the ZoomBrowser EX [File] menu and select [Preferences].

The Preferences dialog will display.

2. Change the format in the Image Format tab and click [OK].

About Saving in the TIFF 16 Bits/Channel Format
When [TIFF 16 bits/channel] is selected as the file format for saving RAW images, 16
bits of data is used to record each RGB channel. This image format can be used in
several application programs, such as Adobe Photoshop LE. Formats other than TIFF
(16 bits/channel) all save the image using 8 bits per RGB channel.

Preview Area

Resets the image quality
settings to the state in which
the image was shot.

Displays the image in the
Preview Area at full size.

Placing a check here applies linear processing to the contrast, sharpness and color saturation.
• The [Linear] option is only enabled when [TIFF 16 bits/channel] is selected as the file

format.

Parameter setting selections are
reflected in the preview image.
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Backing Up Data
You are recommended to use the following procedures to back up your image data after
you add, delete or change images from ZoomBrowser EX.

1. Click the ZoomBrowser EX [File] menu and select [Backup Database].
When the backup is complete, the name of the backup file will display in a dialog.
This file name is needed when the database requires restoring.

The database file may become corrupted if a system crash occurs for some reason
when ZoomBrowser EX is being run at the same time as another software program.
You should restore the data in this case. To avoid unintentional loss, you should back
up your image data frequently.

How to Restore the Database File from a Backup File

1. Click the ZoomBrowser EX [File] menu and select [Restore Database].

2. In the “Restore Database From” dialog, select the file to which the
database was previously backed up and click [Open].
Confirm that the backup file has the [.zbd] file extension.

3. In the “Restore Database To” dialog, input the name of the database to
which the backup will be restored and click [Save].
In most cases you are advised to select the corrupted database and overwrite it.

4. A confirmation dialog usually displays when the backup file is correctly
restored.
This will restore the database file to the state from which it was backed up.
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Loading Images with TWAIN-Compliant
Application Programs (Adobe Photoshop, etc.)
This section explains how to load images with TWAIN-compliant application programs
using Adobe Photoshop LE as an example. Please refer to the manual for each application
program for more details.

Installing the Software
Installing the TWAIN Driver

This program is required to load camera images into the TWAIN-compliant application
programs. For instructions, see “Installing/Uninstalling the Software” (➜ p. 6) or
“Installing the USB Driver” (➜ p. 11, 14).

Installing Adobe Photoshop LE

Place the Adobe Photoshop LE CD-ROM in the drive, double-click [My Computer] on
the Windows desktop, followed by the [Photosle] CD-ROM icon, the [English] and
[Photosle] folders, and the [Setup.exe] file. Follow the on-screen instructions to
complete the installation.

You must input the software serial number to install Adobe Photoshop LE.
It can be found on the CD-ROM case.

Starting the Software
Connecting the Camera to a USB Port

1. Connect the camera to the computer’s USB port. (➜ p. 10)

2. Set the camera’s main switch to [On].
After a moment, an event dialog will allow you to select an application program
to start.

3. Select Adobe Photoshop LE and click [OK].
Adobe Photoshop LE will start.

4. Click the Adobe Photoshop LE [File] menu and select [Import] and [Select
TWAIN_32 Source].

5. Choose your camera model and click [Select].

6. Click the [File] menu and select [Import] and select [TWAIN_32].
The TWAIN Driver will start. (➜ p. 44)
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Connecting via a CF Card Reader or PC Card Slot

1. Place the CF card into the CF card reader or into the PC card adapter and
then into the PC card slot. (➜ p. 17)

2. Click the Windows [Start] menu and select [Programs], [Adobe],
[Photoshop Limited Edition] and [Adobe Photoshop Limited Edition].
Adobe Photoshop LE will start.

3. Click the [File] menu and select [Import] and [Select TWAIN_32 Source].

4. Choose an appropriate source and click [Select].
Select either [Canon XXX USB], where the XXX represents your camera model
name, or [Canon Digital Camera RS-232C] as the source as appropriate. If several
models are listed, select the one that corresponds to your camera.

5. Click the [File] menu and select [Import] and [TWAIN_32].
The TWAIN Driver will start.

Loading Images
Downloading Images from the Camera

1. Click the [Camera] button.
The camera images will appear in the Thumbnail Display Area.

2. Select the images you wish to download and click the [Acquire] button.
The images will appear in the Adobe Photoshop LE window.

3. Click the [Exit] button to close the TWAIN Driver.
To save the loaded images, click the Adobe Photoshop LE [File] menu and
select [Save As]. Input a file name and change the file location and format
settings if necessary.

Downloading Images Directly from a CF Card

1. Double-click the TWAIN Driver’s [My Computer] button.
The My Computer dialog will open.

2. Select the folder containing the images and click [OK].
The CF card images will display in the Thumbnail Display Area.
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Guide to the TWAIN Driver Window

Camera Settings Button
Adjust or check camera
settings. (➜ p. 20)

Rotate 90 Degrees Buttons
Rotates the selected image left or right 90
degrees.

Display Style Buttons

Help Button

Thumbnail Display Area
Image thumbnails (small versions) display
here when the camera is connected.

Main Buttons
These buttons control the main commands,
such as those for loading images and exiting
the TWAIN driver.

Preferences Button
Displays and changes the image
transmission settings. (➜ p. 47)

3. Select the images you wish to download and click the [Acquire] button.
The images will appear in the Adobe Photoshop LE window.

4. Click the [Exit] button to close the TWAIN Driver.
To save the loaded images, click the Adobe Photoshop LE [File] menu and
select [Save As]. Input a file name and change the file location and format
settings if necessary.

Set RAW Param. Button
Sets the image quality
settings for RAW images
(➜ p. 45)
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Setting the Parameters
Up to three sets of parameters for loading images can be set in the TWAIN Driver
using the Parameter Settings dialog in addition to the parameters already set on the
camera.

Please see the Camera User’s Guide to learn how to select the parameters for the
camera that are set with the computer.

1. Click the [Camera Settings] button in the TWAIN Driver window.
The Camera Settings dialog will display.

2. Click the [Parameters] button.
The Parameter Settings dialog will display.

3. Click [Add Set].

4. Set each parameter.

5. Click [Apply to Camera].
The settings will be applied to the camera.

Parameter Settings Dialog

Sets the various
parameters.

Loads the contents
of a parameter set
saved to the
computer’s hard disk.

Click here first to add a new
parameter set to the camera.

Saves the parameter
set to the computer.
To load the saved
parameter set, click
[Load Settings].

Applies the current
parameter set to
the camera.
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Converting RAW Images
Images shot in the RAW format (hereafter RAW images) are recorded without the
image quality being reduced by signal processing or lossy compression. Please refer to
your Camera User’s Guide to learn how to set the camera to shoot in the RAW format.

High-quality RGB images can be obtained from RAW image file data. When a RAW
image is converted, you can also choose to adjust its quality settings to obtain an
image of a higher caliber than if it had first been loaded into image editing software.

Please note that ZoomBrowser EX or the TWAIN Driver are required to load RAW
images onto a computer.

Please see page 48 for further information about the RAW image format.

Converting RAW Images without Adjusting the Quality

1. Select a RAW image from the Thumbnail Display Area of the TWAIN
Driver window.

2. Click the [Acquire] button.
The image will be converted and sent to Adobe Photoshop LE at 8 bits per RGB.
To learn how to change the file transmission format, please see “How to Change
the File Transmission Format” on the next page.

Converting RAW Images with Quality Adjustment

1. Select a RAW image from the Thumbnail Display Area of the TWAIN
Driver window.

2. Click the TWAIN Driver [Set RAW Param.] button.
The RAW Image Parameter Settings dialog will display.

3. Select the quality settings and click [OK].
When an image is adjusted, the “RAW” symbol shown on its thumbnail will
change from gray to green. If multiple RAW images are selected, the parameters
are applied only to the first image. When only one RAW image is adjusted, the
changes are also reflected in the remaining images in the selection.

4. Click the [Acquire] button.
The RAW image will be converted according to the specified parameters and the
data will be sent to Adobe Photoshop LE at 8 bits per RGB channel.
To learn how to change the file transmission format, please see “How to Change
the File Transmission Format” on the next page.

• The image quality settings return to the default settings when the TWAIN Driver is
closed.  The settings will also be reset to the defaults if the connection to the
camera is broken, or if the TWAIN Driver window is refreshed as a result of an
image being shot or deleted with the camera while it is connected.
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RAW Image Parameter Settings Dialog

How to Change the File Transmission Format
1. Click the [Preferences] button in the TWAIN Driver window.

The Preferences dialog will display.

2. Change the transmission format in the [Send RAW image data to the
application] option and click [OK].

About 16-Bit Transmissions
When [16 bits per color channel] is selected as the transmission option for RAW
images, images can be transmitted to the application at 16 bits per RGB channel.
Although colors are expressed more vividly with the 16-bit setting than the 8-bit
setting, the file size increases dramatically. Moreover, some image editing
applications function only partially with files of this format or cannot open them at
all.

Placing a check here applies linear processing to the contrast, sharpness and color saturation.
• The [Linear] option is only enabled when [16 bits per color channel] is selected as the

transmission format.

Click this and a white point of
the image in the Preview Area
to set it as the value for the
white balance.

Preview Area

Resets the image quality
settings to the state in which
the image was shot.

Displays the image in the
Preview Area at full size.

Parameter setting selections are
reflected in the preview image.
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About the RAW Image Format
The camera uses two standard image file formats: JPEG and RAW. In JPEG mode,
the camera processes images after capturing them to produce optimal results.
With this format, images are compressed so more can be stored on a single CF
card. However, the compression is irreversible, meaning that the original image
data cannot be recovered after processing. In contrast, the RAW format records
the image data as captured by the camera’s CMOS without further processing.
RAW images are compressed, but the compression is reversible so that a high-quality
image can be obtained from the decompressed file without any loss of image
quality. Although a RAW file is larger than an equivalent JPEG file, it is still only
approximately one-third the size of an uncompressed file (RGB TIFF), making it
relatively compact.* Please see the Camera User’s Guide to learn how to set the
camera to shoot in RAW mode.

The process of obtaining a high-quality RGB signal from a RAW image is called
“conversion.” Even if you use ZoomBrowser EX or the TWAIN Driver to adjust the
image quality of the original image data in some way, the image retains its original
high quality. In contrast, other standard uncompressed file formats, such as RGB TIFF,
are processed in the camera and further processed by the retouching software,
which reduces the image quality.

Please note that the ZoomBrowser EX or the TWAIN Driver programs are required to
open or adjust RAW images on a computer.

* As measured by standard Canon test conditions.
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Troubleshooting the USB Driver Installation

Check This First
1. Is the camera connected to the computer correctly? (➜ p. 10)
2. Is the camera’s main switch set to [On]?
3. Is the battery charge sufficient?

We suggest that you use the AC adapter to power a camera connected to a
computer.

You will not be able to check the USB driver status if there is a problem with any of the
items above.

If the “Add New Hardware Wizard” (in Windows 2000 it is the “Found New Hard-
ware Wizard”) appears while performing any of the steps above, reinstall the USB
driver using the procedures in the Installing the USB Driver section. (➜ p. 11, 14)

If the three potential problems above are OK, first uninstall the USB driver with the
procedures below before reinstalling it according to the instructions in the Installing the
USB Driver section. (➜ p. 11, 14)

Uninstalling the USB Driver from Windows 98

Check the USB Driver Status
• Does your camera model name appear in the Windows “Scanners and Cameras

Properties” dialog?
Display the “Scanners and Cameras Properties” dialog with the following steps.
1. Click the [Start] menu and select [Settings] and [Control Panel].
2. Double-click the [Scanners and Cameras] icon.

Check to see if your camera model appears here.
The names of scanners and other devices for
which drivers have already been installed will
show in this window.
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What to Do if Your Camera Model Name Is Not in the
“Scanners and Cameras Properties” Device List or if the
[Scanners and Cameras] Icon Is Not in the Control Panel

1. Double-click the [System] icon in the Control Panel and check the [Device
Manager] tab.

2. Check the [Other devices] or [Imaging Devices] categories for an item
corresponding to your camera model. Delete it with the following
procedures.

1. Select the item corresponding to your camera model and click the [Remove]
button.

2. Click the [OK] button in the confirmation dialog.
3. Click the [OK] button to close the “System Properties” dialog.

Delete all copies if the item corresponding to your camera model appears in more
than one category, such as the [Imaging Devices] and [Other Devices] categories,
or if it is duplicated in the [Other Devices] category.

3. On the Windows desktop, double-click the [My Computer] icon, [C:] icon,
[Windows] folder, and [Inf] folder in succession.

4 4 4
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What to Do if the [Inf] Folder Is Not Visible in the [Windows]
Folder
• Follow the procedures below to set the folder options to the “Show all files” setting.

1. Click the [View] menu and select [Folder Options].
2. Click the [View] tab.
3. In the [Hidden files] category, select [Show all files].
4. Click the [OK] button to close the “Folder Options” dialog.

This will show all the previously hidden files.

4. Find and delete the [Drvdata.bin] and [Drvidx.bin] files.

The [Inf] folder contains numerous files. Ensure that you double-check
the file names before you delete any files. Deleting the wrong file may,
in the worst case scenario, result in the failure of your computer to run
the Windows operating system.

5. Double-click the [Other] folder inside the [Inf] folder.

6. Find and delete the [Canon.IncCanon_DC] file.
Skip this step if this file is not present in the [Other] folder.
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Your camera model name
will appear here.

What to Do if Your Camera Model Appears in the “Scanners
and Cameras Properties” Device List

1. Select the name of your camera model and click the [Remove] button.

2. Click [OK] to close the “Scanners and Cameras Properties” dialog.

3. Delete the [Drvdata.bin], [Drvdx.bin] and [Canon.IncCanon_DC] files
using steps 3 to 6 on pages 50 to 51.

Uninstalling the USB Driver from Windows 2000

Begin by logging onto the computer as an Administrator and then uninstall the
USB driver.

1. Double-click the [Add/Remove Hardware] icon in the control panel.
After the “Add/Remove Hardware Wizard” starts, click the [Next] button.
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2. Select [Uninstall/Unplug Device] and click the [Next] button.

3. Select [Uninstall a Device] and click the [Next] button.

4. Select the name of your camera model from the list that displays and
click the [Next] button.

Your camera model
name will appear here.
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5. In the dialog shown below, select [Yes, I want to uninstall this device]
and click the [Next] button.

Click the [Finish] button when the “Add/Remove Hardware Wizard complete”
message displays.

6. On the desktop, double-click the [My Computer] icon, [C:] icon, [Winnt]
folder, and [Inf] folder in succession.

What to Do if the [Inf] Folder Is Not Visible in the [Winnt] Folder
1. Open the [Winnt] folder.
2. Click the [Tools] menu and select [Folder Options].
3. Click the [View] tab.
4. In the [Advanced Settings] category, find the [Hidden Files and Folders]

subcategory and select [Show hidden files and folders].
5. Click the [OK] button to close the “Folder Options” dialog.

 This will show all the previously hidden files and folders.

Your camera model
name will appear
here

4 4 4
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7. Look for files starting with [Oem*].
A number such as 0 or 1 will appear in place of the “*”after the “Oem” prefix in
the file name.
For each [Oem*] file there is a companion [Oem*.pnf] file with the same
number following the “Oem” prefix (e.g. the Oem0 and Oem.pnf files form
one set of Oem files).
• Please note that numerous groupings of “Oem0” files may be present in the [Inf]

folder.

8. Search for the [Oem*] files for Canon digital cameras.
Double-click a file to open it in the Windows Notepad accessory and look for
[;*** Canon Digital Camera USB Setup File ****] in the first line. If you find it, note
down the file name and close Notepad.

9. Delete the [Oem*] file and corresponding [Oem*.pnf] file.
Ensure that you have the correct files before deleting them.

The [Inf] folder contains numerous files. Ensure that you double-check
the file names before you delete any files. Deleting the wrong file may,
in the worst case scenario, result in the failure of your computer to run
the Windows operating system.
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Introducing the Software
This section introduces the powerful software programs for the Macintosh platform
contained on the CD-ROMs (2) included with the camera.

 Canon Digital Camera Solution Disk

ImageBrowser

To load camera images, start ImageBrowser.

Camera Connection Functions
(Also effective for CF card readers or PC card readers)

• Displays camera images.
• Downloads camera images to the computer.
• Loads and saves RAW images in the RAW format
• Converts and saves RAW images in other formats
• Saves computer images to a CF card in the camera.
• Connecting to a USB port automatically starts ImageBrowser and displays the

camera images.
• Sets the camera parameters.

Image File Management Functions

• Displays, moves, copies or deletes images stored on computer disks.
• Allows simple editing procedures, such as image color adjustments and cropping.
• Displays all the files in a specified folder at once.
• Displays files in chronological order in a window that looks like a time tunnel.
• Replays images from the computer one-by-one at full screen size to simulate a slide

show.

Image Printing Functions

• Prints multiple images on the same page.
• Allows you to freely resize images and change layouts.
• Allows you to place titles or captions anywhere on the page.

Supports PhotoStitch Panoramas

• Allows you to select camera images or images registered with ImageBrowser and
start PhotoStitch from within ImageBrowser to merge a series of images into a
panorama in a few simple steps.
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Supports the Adobe Photoshop LE Photo Retouching Program

• This photo-retouching program can be used to edit and apply special effects to
your images if it is installed and started.

Adjusting Images for Transmission by E-mail

• Allows you to adjust image size and compression settings so that large image files
can be made smaller for transmission as e-mail attachments.

PhotoStitch
• Effortlessly merges images that are shot over several frames with a camera.
• Merges any number of images horizontally or vertically, or in a matrix format.
• Makes images with straight lines appear natural not crooked when merged. (Select

the wide display format.)
• A 360-degree scene shot in several frames can be merged into a 360-degree

image and saved in the QuickTime VR format, making it appear as if you were
standing in the middle of the image looking about in all directions.

RemoteCapture
• Connecting via a USB port allows you to release the EOS D30’s shutter button from

the computer. The images are loaded directly into the computer.
• Connecting via a USB port also allows you to load images directly into the

computer by clicking the camera’s shutter button.
• Allows interval shooting with custom interval and frame settings.

Plug-In Module
Canon Digital Camera Plug-In Module

The Plug-In Module is the driver utility program that works within plug-in compliant
application programs, such as Adobe Photoshop LE, to load camera images directly
into the application program. The Plug-In Module is started from within the plug-in
compliant application program. It cannot be used as a stand-alone program.

  Adobe Photoshop LE CD-ROM

Adobe Photoshop LE
• Allows you to edit images, apply special effects, print and create sophisticated

graphics for the web.
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Camera and Software Compatibility
The Canon Digital Camera Solution Disk contains a number of software programs and
drivers. Check the chart below for the compatibility of your particular camera model with
each program’s special functions.

*1  Only compatible with Power Macintosh NEW G3/G4, PowerBook G3, iMac and iBook models with built-in USB ports.

*2  Only compatible with the USB interface.
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System Requirements
The following system requirements must be met to install and operate the software.

=Computer Model
Power Macintosh, PowerBook, iMac or iBook

=OS
Mac OS 8.1 or higher, QuickTime 3 or higher

=CPU
PowerPC

=RAM
20 MB or more of application memory

=Interface
USB: (Power Macintosh NEW G3/G4, PowerBook

G3, iMac, iBook)
• Limited to genuine Apple Computer brand

models with a built-in USB interface
• iMac computers running Mac OS 8.1 require

installation of the “iMac Update 1.0” and
“iMac Firmware Update 1.0”

=Free Hard Disk Space
Canon Utilities

ImageBrowser: 20 MB or more
PhotoStitch: 30 MB or more
RemoteCapture: 15 MB or more

Canon Digital Camera Plug-In Module: 15 MB or more
Adobe Photoshop LE: 40 MB or more

=Display
Minimum: 800 x 600 pixels, 256 colors
Recommended: 1,024 x 768 pixels, thousands of colors

or more

• A CD-ROM drive is required to install the software.
• Plug-In Module is compatible with Adobe Photoshop 3.0 and higher versions.
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Installing/Uninstalling the Software
Installing from the Canon Digital Camera Solution Disk

1. Close any programs that are running.

2. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.

3. Double-click the [CD-ROM] icon and the [Canon Digital Camera Installer]
icon.
The installer panel will display.

4. Click [Software Installation].

5. Select the programs you wish to install and follow the on-screen
instructions to install them.

6. Click the [Quit] button when the installation is complete and restart the
computer if prompted.
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Installing from the Adobe Photoshop LE CD-ROM
Place the Adobe Photoshop LE CD-ROM in the drive and double-click the CD-ROM icon,
the [Adobe Photoshop LE] folder and the [Install Photoshop LE] icon. Follow the on-
screen instructions to continue with the installation.

You must input the software serial number to install Adobe Photoshop LE.
It can be found on the CD-ROM case.

Uninstalling the Software
To uninstall a program, drag its folders to the Trash. Be careful, however, not to
accidentally delete any of your images that may be stored in these folders.

For instructions on how to uninstall the Plug-In Module, open the [Canon Utilities] folder
and [Digital Camera Plug-In] folder and read the [ReadMe] file.
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Connecting the Camera to a Computer
Selecting a Connection Method
The following different interfaces and methods can be used to connect the camera to a
computer. Once a connection has been established using one of the methods, you can
start the software and begin to load images from the camera (➜ p. 68, 87).

Use the AC Adapter
• We suggest that you use the AC adapter while the camera is connected to a

computer to conserve battery power.

USB Port (➜ p. 65)

The USB interface can start the image loading software automatically.

CF Card Reader or PC Card Slot  (➜ p. 67)

If you have a computer equipped with a PC card slot, a CF card reader or a PC card
reader, you can place the camera’s CF card into these devices to establish a direct
connection. You will require a PC card adapter for PC card slots.

PC Card Adapter

CF Card

USB Cable Connector Shapes

Computer EndCamera End

Computer USB Port

The USB port is
marked with
this symbol.
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Connecting to a USB Port

Requirements for the USB Interface
• The USB interface can only be used to connect the camera to genuine Apple

Computer brand Power Macintosh New G3/G4, PowerBook G3, iMac and iBook
models with built-in USB connectors.

• Connect the USB cable directly to one of the computer’s main USB ports. The
interface may not function correctly if the camera is connected via a USB hub.

• The interface may not function correctly while other USB devices, excluding USB
mice and keyboards, are connected. If this problem arises, detach the camera and
the other devices, and reconnect the camera only.

Important
• Please do not place your computer in the sleep mode while the camera is

connected to its USB port. If the computer goes into sleep mode while the camera
is connected to a USB port, do NOT disconnect the USB cable from the camera or
computer. Try to revive the computer. If the USB cable is detached in sleep mode,
some computers may not return to active mode correctly. For instructions
regarding the sleep mode, please consult the manual accompanying your
computer and operating software.
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1. Attach the supplied USB cable to a USB port directly on the computer
and to the DIGITAL terminal on the camera as shown below.
• There is no need to turn the camera or computer power off when attaching or

detaching the USB cables.
• Please consult your computer’s manual for the location of the USB ports.

Precaution for Unplugging Cables
from the DIGITAL Terminal
• Always press the PUSH button on the

connector to detach the cable from the camera’s
DIGITAL terminal.

USB Port

USB Connector

USB Connector

2. Insert the connector so that the4 marks on
the connector and camera align.

PUSH Button

1. Open the expansion
electronics cover.

DIGITAL Terminal
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Connecting via a CF Card Reader or PC Card Slot
To load images directly from a CF card to a computer, eject the card from the camera,
place it in a separately sold PCMCIA card adapter (PC card adapter) and insert the
assembly into the PC card slot.

The adapter is not required if your computer is equipped with a CF card reader. Place the
CF card directly into the reader.

1. Place the CF card in the PC card adapter.

2. Insert the loaded PC card adapter into the computer’s slot or PC card
reader.
The requirements for the power being on or off when the PC card adapter is
inserted differ according to the product. Please consult the manuals accompanying
your equipment.

Insert the Adapter in the Slot.

Place the CF Card in the Adapter.
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Using ImageBrowser the First Time
(From Loading to Printing)
This section provides a simple explanation of the procedures for using ImageBrowser to
perform each of the steps from loading to printing. Please refer to the ImageBrowser
Help file for more details.

What to Do if a Warning Dialog Displays
• If a set period of time passes without a camera function being accessed when

the camera is connected via the USB interface, a message on the computer
display will ask if you wish to remain connected. If you do not access a
function, the camera will close the connection after an additional minute
passes. The time required for the message to display will vary with the camera’s
auto power off setting. Please see the Camera User’s Guide for details. (The
message will not display and the camera will not disconnect if an AC adapter
is used or auto power off is turned off.)

• To reconnect the camera, press the camera’s shutter button.

Starting ImageBrowser
USB Interface

1. Attach the camera to the computer with the USB cable. (➜ p. 66)

2. Set the camera’s main switch to [On].
ImageBrowser will start automatically and display the Communication Settings
dialog.

3. Confirm that [USB Port] and your camera model are selected and click
the [Set] button.
The images from the camera will display as small thumbnail images in the
ImageBrowser Camera Window. (➜ p. 70)
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How to Set ImageBrowser to Not Start Automatically
1. Open the Apple menu  and select [Control Panels] and [Canon USB Camera].

The “Settings for USB Connection” dialog will display.
2. Click the [The application program below will start.] option to clear the check mark.
3. Click the close box at the upper left to close the dialog. ImageBrowser will cease to

start automatically thereafter.

CF Card Reader or PC Card Slot Interface

1. Place the CF card into the CF card reader or into the PC card adapter and
then into the PC card slot. (➜ p. 67)

2. Start ImageBrowser.
Double-click the [Canon ImageBrowser] icon on the desktop to start the program.

If the [Canon ImageBrowser] icon does not appear on the desktop, open the
[Canon Utilities] folder and [ImageBrowser] folder and double-click the
[ImageBrowser] icon.

3. Double-click the [DCIM] folder in the Explorer View Section.
The images from the CF card will display in ImageBrowser Camera Window as small
thumbnail images. (➜ p. 70)

Clear the check mark to stop
ImageBrowser from
automatically starting.

Click here to close the dialog.

Canon ImageBrowser Icon

Explorer View Section
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The ImageBrowser Camera Window
The Camera Window will open when a connection to a camera or CF card is initiated.
Thumbnail (small) images will display.

How to Check and Change Various Camera Settings
• You can adjust the date, time and owner settings in the Camera Settings dialog

using the computer when the camera is connected. You can also check the battery
charge and remaining memory capacity.
1. Click the [SETUP OPTIONS] button.
2. Check or change the settings.

Input a camera owner name here. (up
to 31 characters)

Click this button to synchronize with
the computer’s date and time settings.

Set the date and time.

Check the battery charge here.

Formats the CF card in the camera.

Check the remaining memory capacity
here.

Sets the camera parameters (➜ p. 91)

SETUP OPTIONS Button
Sets various camera
settings (see inset below)
using the computer.

An image of the connected
camera or CF card will display.

Thumbnail

UPLOAD Button
Copies images from the computer
to the camera or CF card. (➜ p. 79)

DELETE Button
Deletes the
selected images.

DOWNLOAD Button
Copies selected images to the computer
from the camera or CF card. (➜ p. 72)
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Loading and Saving Images from the Camera

1. Select [Macintosh HD] in the Explorer View Section.

2. Create a new folder in which to save the images from the camera.
Open the [File] menu and select [New Folder]. A folder with the name “Untitled”
will be created. Click the folder and change the name as you wish.

3. Select the new folder in the Explorer View Section.

Explorer View Section
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4. Select the images that you wish to download from the Camera Window
and click the [DOWNLOAD] button.
Click the thumbnail you wish to select or press [Shift] and click to select
multiple thumbnails.

The downloaded images will be saved to the computer disk and appear in the
Browser Window.
• You can also download images to the computer by dragging them from the

Camera Window and dropping them on the Browser Window or Explorer
View Section.

To disconnect the camera, click the close box  at the upper left of the Camera
Window. The Camera Window will close.

Thumbnail

Browser Window

Explorer View Section



73

W
in

d
o

w
s

M
a
ci

n
to

sh

Printing Images

1. Select the image(s) you wish to print and click the [PRINT LAYOUT] button.
The Print window will display with the images arranged in an auto layout.

2. Adjust the print settings if you wish to change the page layout.

3. Click the [PRINT] button in the Print window.

Print Window
Please see the ImageBrowser Help file for more details on the Print window.

Edit the Page Title
Open the [Edit]
menu and select
[Edit Header].

Change the Layout
Drag the images to
change the layout.

Add Text
Open the [Edit]
menu and select
[Add Text].

This button displays
the Print dialog.

This changes the default number of images printed per page.

Click this to rotate the selected image.

Click this to reset the
image layout to the
initial setting.

Change the Image Size
Drag the border to resize
the image.

Add a caption to an image
Click an image and select
[Edit Caption] from the
[Edit] menu.

Click this to select
a layout type.
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Setting the Image Size for Printing

Fixed Photo Sizes
Images can be printed at standard photo print sizes.
Since the images are printed without gaps between them, they look like photo prints
when they are cut with a cutter.

1. Click the [Layout Options] button in the Print window.
The Layout Options dialog will display.

2. In the [Layout Type] category, select [Fixed Photo Size].

3. Set the photo size and click [OK].

Printing on Canon Perforated Paper
The [Canon Perforated Paper] option will be selectable in the Layout Options dialog if you
are using a Canon BJ printer that supports Canon Perforated Paper media. Canon
Perforated Paper has perforations at the preset dimensions allowing you to print at the
specified size and simply tear along the perforated lines to produce an image with the
appearance of a finished photo print. Please consult the BJ Solutions Disk operating guide
for your printer for more details.
The [Photo Paper Pro 4”x6”] paper stock included in the [Settings] category will be
available for purchase starting from February 2001.
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Using Additional ImageBrowser Functions
This section explains the additional features of ImageBrowser. Please refer to the
ImageBrowser Help file for more details.

Displaying Images
Zooming Images In and Out

You can zoom images in and out by clicking the  (REDUCE) or  (ENLARGE)
button.

Zooming a Single Image

Double-click an image in the Browser Window to display it in the Viewer Window.

About the Viewer Window Edit Panel

Double-click the target image.

Edit Panel

ADJUST COLOR Button
Color, brightness and contrast can be
adjusted in the Adjust Color dialog.

CROP Button
Drag the mouse cursor to select a crop
area and click the [CROP] button to trim
unwanted portions of images.

SAVE Button
Saves the edited
image as a new
file.
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Displaying Images in Chronological Order

Select a folder, choose the [Display] menu and select [Switch to TimeTunnel]. All of the
images in the selected folder will display in a time tunnel. To return to the Browser
Window, choose the [Display] menu and select [Switch to Browser View].

Showing Images in a Slide Show

The slide show function displays images saved onto the computer disk one-by-one at
full-screen size as if they were part of a slide show.

1. Click the [Display] menu and select [Slide Show Options].

2. Select a play method.
The “Slide Show Options” dialog will display. Set a play interval and a transition
effect and click the [OK] button.

3. Select images from the ImageBrowser Browser Window for showing.

4. Click the [Display] menu and select [Slide Show].
The selected images will play in order. The slide show will close after the last
image is displayed. If the slide show is set to repeat, press the [Esc] key to close
the slide show.

Drag the tab up or
down to go
backward or forward
in time.
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Organizing Images
Changing the File Location

You can move an image file or folder by dragging and dropping it in another location.

(a) Drag and drop images from the Browser Window to another
folder in the Explorer View Section.

(b) Drag and Drop a Folder within the Explorer View Section.

Refreshing the Contents of the Browser Window

If you have used the Macintosh Finder or another program to move or edit
images that are registered with ImageBrowser, you should click the [Display]
menu and select [Refresh].

Browser Window

The file or folder will
move to the item
outlined in blue.

Explorer View Section
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Erasing Images
Erasing Images Singly

Select the target image in the Browser Window and click the [SEND TO TRASH]
button.

Erasing Images by Folder

1. Click the target folder in the Explorer View Section.
The images in the folder will display in the Browser Window.

2. Click the [SEND TO TRASH] button.

The deleted image files and folders are moved to the Trash folder on the desktop.

To restore the deleted items, open the desktop Trash folder and drag and drop the
target files or folders to their original locations.

Browser Window
Click the image in the Browser
Window to delete a single image.

Explorer View Section
Click on a folder in the
Explorer View Section to
delete all its images in
one step.

SEND TO TRASH Button
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Follow the instructions
to merge the images.

Saving Computer Images to a CF Card in the Camera

1. Open the Camera Window. (➜ pp. 68-70)

2. Click the [UPLOAD] button in the Camera Window.
The “Select Images to Add” dialog will display.

3. Select the images from the computer and click the [Open] button.
The “Save to Camera” dialog will display.

4. Select image size and resizing options and click the [Save to Camera]
button.
The selected image will be saved onto the camera’s CF card.

Adding Sound Annotations to Images
If your computer has a microphone, you can attach a sound annotation to an image by
clicking it in the Browser Window, choosing the [Sound] menu and selecting [Record].

Merging Panoramic Images with PhotoStitch
To Merge Images Registered in ImageBrowser

• You can merge a series of overlapping images into a single, seamless panorama.

• Select the images in the browser area, choose the [Edit] menu and select
[PhotoStitch]. The PhotoStitch program will start.

• Follow the instructions in the guidance window to merge the images.

• Please refer to the PhotoStitch Help file for more details.
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Adjusting Images for Transmission by E-mail
You can adjust the image size and quality to reduce the file size of an image for
transmission as an e-mail attachment.

1. Select the target image(s) in the Browser Window.

2. Click the [File] menu and select [Create Image for Email].

3. Adjust the image size and quality.
The e-mail image creation window will display.
Set the image size and quality and follow the on-screen messages to complete the
procedures.

4. Click the [Finish] button.
When you click the [Finish] button, the image will appear in the [Email Images]
folder and your e-mail program will start.

5. Create a new message.
Drag and drop the image from the [Email Images] folder into the message. Input
your message, a subject, the recipient’s address and send the message.
• Some e-mail programs will not start automatically. Start them manually if required.
• The image file to be sent via e-mail will be saved to the [ImageBrowser.mail]

folder in the [ImageBrowser] folder. If you cannot drag and drop the file from
the [Email Images] folder, look for it in the [ImageBrowser.mail] folder and
attach it to your message.

Editing and Applying Special Effects to Images

1. Confirm that Adobe Photoshop LE has been installed.

2. Select an image from the Browser Window of ImageBrowser.

3. Click the [Edit] menu and select [Adobe Photoshop].
Please refer to the Adobe Photoshop LE Help file and electronic guide
(User Guide.pdf) for instructions for this program.

4. Edit and apply special effects to the image.
• ImageBrowser supports the BMP, JPEG, PICT and TIFF file formats.
• Click the [Display] menu and select [Refresh] to update the folder data.
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Editing the Print Order Settings (DPOF)
You can specify which images on a CF card you wish to print as well as the number of
copies. You can also select the print type and whether or not the shooting date and file
number information is printed with the image. A convenient feature of these settings is
that they comply with the DPOF (Digital Print Order Format) standards, which allow you
to print on any DPOF-compliant digital printer or to order prints from a participating
photo developing laboratory.

1. Open the Camera Window. (pp. 68-70)

2. Click the [Slide/DPOF] button.
The Edit Slide/DPOF window will display.

3. Click [Print Order (DPOF)] at the window's upper left.

4. Select the print type from among the [Standard Print], [Index Print] or
[Both] options.
• Standard .. Set the number of copies of the images you wish to print in the

column below the thumbnails.
• Index ....... A check mark will appear below the thumbnails selected for printing.

5. Click the [Save to Camera] button.
The print order settings will be saved to the CF card in the camera.

6. Click the [Quit] button.

• A warning message will display if ImageBrowser encounters print settings data it
does not support on a CF card with print settings created by a non-Canon brand
DPOF-compliant digital camera. If any print settings on such a card are changed, all
of them will be overwritten by ImageBrowser and lost.

• Some printers or photo developing laboratories may not be able to reflect all of the
print settings in the output.
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Shooting with the RemoteCapture Function
The RemoteCapture program will start if you click the ImageBrowser [Edit] menu and
select [RemoteCapture]. RemoteCapture lets you activate the camera’s shutter button
remotely from the computer. The captured image is automatically saved into the
ImageBrowser folder that is currently selected.

RemoteCapture Window
Thumbnail View
Displays thumbnails of all the images
shot in the current session since
RemoteCapture was started.

Number of Frames that Can Be Captured
Displays the number of images that can be
saved to the computer or the camera’s CF card.

Displays the distribution
of brightness data.

Displays the location in
which files are saved.
(➜ p. 84)

Control Buttons
These buttons control
the basic RemoteCapture
functions. (➜ p. 83)

Displays the image information.

Allows you to add comments to images.

Image View
Displays the image selected
in the Thumbnail View.

How to Start RemoteCapture Instead of Displaying the
Camera Window
The settings can be changed so that ImageBrowser automatically starts
RemoteCapture instead of its Camera Window when the camera is connected to
the computer’s USB port.

(1)Click the ImageBrowser [Edit] menu and select [Preferences].
(2) In the Preferences dialog, click the [Camera] tab and set [Camera Controls for

USB Connection] to [Start RemoteCapture].
The RemoteCapture window will now show instead of the ImageBrowser Camera
Window when the camera is connected to the USB port and starts ImageBrowser.
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About the RemoteCapture Control Buttons
The control buttons are used to shoot, delete and display images.

Using Interval and Timer Shooting

RemoteCapture can be used to shoot a set number of images at specified intervals
(Interval Shooting) or to shoot an image after a specified delay (Timer Shooting).

Interval Shooting
You can set the number of frames and the interval at which they are shot.

1. Click the [File] menu and select [Interval Shooting].
The Interval Shooting dialog will display.

2. Set the number of frames and interval value and click [Start].
RemoteCapture will start interval shooting, capturing the specified number of
images at the specified intervals.

Timer Shooting
You can set the time delay before an image is shot.

1. Click the [File] menu and select [Timer Shooting].
The Timer Shooting dialog will display.

2. Set the number of seconds and click [Start].
RemoteCapture will start timer shooting, capturing an image after the
specified delay.

Printing a Thumbnail Index Sheet

Thumbnails you select in the Thumbnail View can be printed in order on a single index
sheet by clicking the [File] menu and selecting [Print Index]. Since the file name and
shooting date and time can be printed with each image, index sheets serve as a
convenient record of and reference for your images.

Click here to trigger the camera and take a shot. The image is
automatically saved to the computer. Pushing the camera’s
shutter button directly will also save the image to the
computer.

Rotates the image saved to the computer by 90 degrees either way.
Select one of these to automatically rotate and save images shot
with the camera swiveled from a horizontal to a vertical orientation.

Displays the image selected in the Thumbnail View in the Viewer.

Deletes the image selected in the Thumbnail View. Please take proper
caution before deleting because deleted images are completely
erased from the computer in one step with this button.
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Precautions when Shooting with RemoteCapture
• The camera’s shooting settings cannot be set from RemoteCapture. They must be

set on the camera.

• If your computer is set to go into sleep mode, there is no guarantee that
RemoteCapture will continue to function after the computer has entered sleep
mode. Always turn off the sleep function before you start shooting with
RemoteCapture.

• If the camera is set for “mirror lockup” shooting, the shutter will activate
approximately two seconds after the release button is clicked in RemoteCapture.

• The camera’s auto power save setting is disabled while connected to
RemoteCapture, and the power remains on until manually turned off. You are
recommended to power the camera with a household power source while it is
connected.

• Please note that the camera will not be able to shoot at the specified interval if it is
shorter than the time required to send the image and save it on the computer.

Changing the Save Location and Other Preferences

The Preferences dialog can be opened by clicking the RemoteCapture [File] menu
and selecting [Preferences]. This dialog can be used to change the save location
and settings.

Sets the folder in which the
image file is saved.

Selects whether the image is saved
only on the computer or on the
camera’s CF card too.

Sets the image file prefix. If the prefix
is set to [Capture], for example, the
first image will be named
[Capture_00001.jpg] and successive
images will have higher numbers.
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Converting RAW Images
Images shot in the RAW format (hereafter RAW images) are recorded without the image
quality being reduced by signal processing or lossy compression. Please refer to your
Camera User’s Guide to learn how to set the camera to shoot in the RAW format.

High-quality RGB images can be obtained from RAW image file data. When a RAW
image is converted, you can also choose to adjust its quality settings to obtain an image
of a higher caliber than if it had first been loaded into image editing software.

Please note that ImageBrowser or the Plug-In Module are required to load RAW images
onto a computer.

Please see page 94 for further information about the RAW image format.

Converting RAW Images without Adjusting the Quality

1. Select a RAW image.
Select a RAW image from the Browser Window of ImageBrowser.

2. Click the [File] menu and select [Convert RAW Images].
The image is converted and saved in a new TIFF (8 bits/channel) file. To learn
how to change the file format, please see “How to Change the File Format” on
the next page.

Converting RAW Images with Quality Adjustment

1. Select a RAW image from the Browser Window of ImageBrowser.

2. Click the [File] menu and select [Convert RAW Images with User Defined
Parameters].
The RAW Image Parameter Settings dialog will display.

3. Select the quality settings and click [OK].
The RAW image is converted according to the specified parameters and saved
in a new TIFF (8 bits/channel) file. If multiple RAW images are selected, the
parameters are applied only to the first image. When only one RAW image is
adjusted, the changes are also reflected in the remaining images in the
selection. To learn how to change the file format, please see “How to Change
the File Format” on the next page.
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RAW Image Parameter Settings Dialog

How to Change the File Format
1. Click the ImageBrowser [Edit] menu and select [Preferences].

The Preferences dialog will display.
2. Change the format selected in the [File Format] tab and click [OK].

About Saving in the TIFF 16 Bits/Channel Format
When [TIFF (16 bits/Channel)] is selected as the file format for saving RAW images,
16 bits of data is used to record each RGB channel. This image format can be used
in several application programs, such as Adobe Photoshop LE. Formats other than
TIFF (16 bits/Channel) all save the image using 8 bits per RGB channel.

Placing a check here applies linear processing to the contrast, sharpness and color saturation.
• The [Linear] option is only enabled when [TIFF (16 bits/Channel)] is selected as the file format.

Click this and a white point
of the image in the Preview
Area to set it as the value
for the white balance.

Preview Area

Resets the image quality settings
to the state in which the image
was shot.

Displays the image in the
Preview Area at full size.

Parameter setting selections
are reflected in the preview
image.
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Loading Images with Plug-In Compliant
Application Programs (Adobe Photoshop, etc.)
This section explains how to load images with Plug-In compliant application programs
using Adobe Photoshop LE as an example. Please refer to the manual for each application
program for more details.

Installing the Software
Installing Plug-In Module

This program is required to load camera images into Plug-In compliant application
programs. For instructions, see “Installing/Uninstalling the Software” (➜ p. 62).

Installing Adobe Photoshop LE

Place the Adobe Photoshop LE CD-ROM in the drive and double-click the CD-ROM
icon, the [Adobe Photoshop LE] folder and the [Install Photoshop LE] icon. Follow the
on-screen instructions to continue with the installation.

You must input the software serial number to install Adobe Photoshop LE.
It can be found on the CD-ROM case.

Copying Plug-In Module to the [Plug-Ins] Folder

1. Open the [Canon Utilities] and [Digital Camera Plug-In] folders.

2. Copy the [Canon Digital Camera] file to the Adobe Photoshop LE
[Import/Export] folder.
Open the [Adobe Photoshop LE], [Plug-Ins] and [Import/Export] folders and copy the
[Canon Digital Camera] file into the [Import/Export] folder.

Starting Adobe Photoshop LE
Connecting the Camera to a USB Port

1. Connect the camera to the computer’s USB port. (➜ p. 66)

2. Set the camera’s main switch to [On].
Although ImageBrowser will automatically start after a moment, you need to close
it at this point.
• See page 69 to learn how to set ImageBrowser so that it does not start

automatically.

3. Start Adobe Photoshop LE. (➜ p. 89).
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What to Do if the “ImageBrowser not found” Dialog Appears
If you install only the Canon Digital Camera Plug-In Module without ImageBrowser,
the “ImageBrowser not found” dialog may display. If this happens, use the following
procedures to prevent ImageBrowser from attempting to start automatically.

1. Click the [OK] button on the “ImageBrowser not found” dialog.
2. In the “Settings for USB connection” dialog, click the [The application program

below will start.] option to clear the check mark.
3. Close the “Settings for USB connection” dialog.
This will prevent the “ImageBrowser
not found” dialog from appearing
again when the camera is
connected.
• The “Settings for USB connection”

dialog can be opened by choosing
the Apple menu  and selecting
[Control Panels] and [Canon USB
Camera]. (➜ p. 69)

Connecting via a CF Card Reader or PC Card Slot

1. Place the CF card into the CF card reader or into the PC card adapter and
then into the PC card slot. (➜ p. 67)

2. Start Adobe Photoshop LE. (➜ p. 89).

Click here to close the dialog.

Click here to clear the check mark.
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Starting Plug-In Module and Loading Images
Downloading Images from the Camera

1. Click the Adobe Photoshop LE [File] menu and select [Import] and
[Canon Digital Camera].
Plug-In Module will start.

2. Click the    icon and set the communication settings.
Confirm that [USB Port] and your camera model have been selected and click the
[Set] button.

3. Click the [Camera] button.
The images from the camera will display in the Thumbnail Display Area.

4. Select the images you wish to download and click the [Acquire] button.
The images will appear in the Adobe Photoshop LE window.

5. Click the [Quit] button to close Plug-In Module.
To save the loaded images, click the Adobe Photoshop [File] menu and select [Save].
Input a file name and change the file location and format settings if necessary.

Downloading Images Directly from a CF Card

1. Click the Adobe Photoshop LE [File] menu and select [Import] and
[Canon Digital Camera].
Plug-In Module will start.

2. Click the [Computer] button.

3. Select the folder containing the images and click [Select].
The images on the CF card will appear in the Thumbnail Display Area.

4. Select the images you wish to download and click the [Acquire] button.
The images will appear in the Adobe Photoshop LE window.

5. Click the [Quit] button to close Plug-In Module.
To save the loaded images, click the Adobe Photoshop LE [File] menu and
select [Save As]. Input a file name and change the file location and format
settings if necessary.
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Rotate 90 Degrees Buttons
Rotates selected image left or right
90 degrees.

Guide to the Plug-In Module Window

Preferences Button
Displays and changes
various Plug-In Module
settings. (➜ p. 93)

Camera Settings Button
Use to display and change
the camera settings.
(➜ p. 70)

Communication
Settings Button
Sets the settings
for communicating
with the camera.

Display Style Button
Changes the shape of the
thumbnail display area.

Image Information Button
Displays image details

RAW Button
Adjusts the quality at
which RAW images
are converted.
(➜ p. 92)

Main Buttons
Use them to perform the main
commands such as acquiring images and
closing the program.

Thumbnail Display Area
Thumbnails (small versions) of
the camera’s images display
here when it is connected.
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Setting the Parameters
Up to three sets of parameters for loading images can be set in the Plug-In Module
using the Parameter Settings dialog in addition to the parameters already set on the
camera.

Please see the Camera User’s Guide to learn how to select the parameters for the
camera that are set with the computer.

1. Click the [Camera Settings] button in the Plug-In Module window.
The Camera Settings dialog will display.

2. Click the [Parameters] button.
The Parameter Settings dialog will display.

3. Click [Add Set].
Click [Add Set] and select the number of the set you wish to add.

4. Set each parameter.

5. Click [Apply to Camera].
The settings will be applied to the camera.

Parameter Settings Dialog

Applies the current
parameter set to the
camera.

Sets the various parameters.

Loads the contents of a
parameter set saved to the
computer’s hard disk.

Click here first to add a new
parameter set to the camera.

Saves the parameter set to
the computer.
To load the saved parameter
set, click [Load Settings].
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Converting RAW Images
Images shot in the RAW format (hereafter RAW images) are recorded without the image
quality being reduced by signal processing or lossy compression. Please refer to your
Camera User Guide to learn how to set the camera to shoot in the RAW format.

High-quality RGB images can be obtained from RAW image file data. When a RAW
image is converted, you can also choose to adjust its quality settings to obtain an image
of a higher caliber than if it had first been loaded into image editing software.

Please note that ImageBrowser or the Plug-In Module are required to load RAW images
onto a computer.

Converting RAW Images without Adjusting the Quality

1. Select a RAW image.
Select a RAW image from the Thumbnail Display Area of the Plug-In Module.

2. Click the [Acquire] button.
The image will be converted and sent to Adobe Photoshop LE at 8 bits per RGB.
To learn how to change the file transmission format, please see “How to Change
the File Transmission Format” on the next page.

Converting RAW Images with Quality Adjustment

1. Select a RAW image.
Select a RAW image from the Thumbnail Display Area of the Plug-In Module.

2. Click the Plug-In Module [RAW] button.
The RAW Image Parameter Settings dialog will display.

3. Select the quality settings and click [OK].
When an image is adjusted, the “RAW” symbol shown on its thumbnail will
change from white to green. If multiple RAW images are selected, the parameters
are applied only to the first image. When only one RAW image is adjusted, the
changes are also reflected in the remaining images in the selection.

4. Click the [Acquire] button.
The RAW image will be converted according to the specified parameters and the
data will be sent to Adobe Photoshop LE at 8 bits per RGB channel.
To learn how to change the file transmission format, please see “How to Change
the File Transmission Format” on the next page.

• The image quality settings return to the default settings when the Plug-In
Module is closed.  The settings will also be reset to the defaults if the connection
to the camera is broken, or if the Plug-In Module window is refreshed as a result
of an image being shot or deleted with the camera while it is connected.
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RAW Image Parameter Settings Dialog
Preview Area

Placing a check here applies linear processing to the contrast, sharpness and color saturation.
• The [Linear] option is only enabled when [16 bits per color channel ] is selected as the

transmission format.

How to Change the File Transmission Format
1. Click [Preferences] button in the Plug-In Module window.

The Preferences dialog will display.
2. Change the transmission format in the [Send RAW image data to the

application as] option. and click [OK].

About 16-Bit Transmissions
When [16 bits per color channel] is selected as the transmission option for RAW
images, images can be transmitted to the application at 16 bits per RGB channel.
Although colors are expressed more vividly with the 16-bit setting than the 8-bit
setting, the file size increases dramatically. Moreover, some image editing
applications function only partially with files of this format or cannot open them at
all.

Click this and a white point
of the image in the Preview
Area to set it as the value
for the white balance.

Resets the image quality settings
to the state in which the image
was shot.

Displays the image in the
Preview Area at full size.

Parameter setting selections
are reflected in the preview
image.
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About the RAW Image Format
The camera uses two standard image file formats: JPEG and RAW. In JPEG mode,
the camera processes images after capturing them to produce optimal results.
With this format, images are compressed so more can be stored on a single CF
card. However, the compression is irreversible, meaning that the original image
data cannot be recovered after processing. In contrast, the RAW format records
the image data as captured by the camera’s CMOS without further processing.
RAW images are compressed, but the compression is reversible so that a high-quality
image can be obtained from the decompressed file without any loss of image
quality. Although a RAW file is larger than an equivalent JPEG file, it is still only
approximately one-third the size of an uncompressed file (RGB TIFF), making it
relatively compact.* Please see the Camera User’s Guide to learn how to set the
camera to shoot in RAW mode.

The process of obtaining a high-quality RGB signal from a RAW image is called
“conversion.” Even if you use ImageBrowser or the Plug-In Module to adjust the
image quality of the original image data in some way, the image retains its original
high quality. In contrast, other standard uncompressed file formats, such as RGB TIFF,
are processed in the camera and further processed by the retouching software,
which reduces the image quality.

Please note that the ImageBrowser or the Plug-In Module programs are required to
open or adjust RAW images on a computer.

* As measured by standard Canon test conditions.
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Troubleshooting the Computer Connection

Double-Check:
1. Is the cable between the camera and computer correctly attached?

Windows Platform (➜ p. 10)
Macintosh Platform (➜ p. 66)

2. Is the camera’s main switch set to [On]?

3. Is the battery charge sufficient?
We suggest that you use the AC adapter to power a camera connected to a computer.

If the above conditions are met, check the following items.

• Have you tried switching the cable to a different port?
If there is more than one port, try switching the cable to another port.

• Are the communication settings appropriate?
If the settings for the port to which the camera is connected are incorrect, the
Communication Settings dialog will display.

Windows Platform

Macintosh Platform

If these remedies do not work, please contact the nearest Canon Customer Support
Help Desk.

Select [USB].

Select the name of your
camera model.

Select the name of your
camera model.

Select [USB Port].
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Customer Support
Canon Customer Support

Canon Inc.
30-2 Shimomaruko 3-chome, Ohta-ku, Tokyo
146-8501, Japan

NORTH AMERICA
Canon U.S.A., Inc.
Canon Customer Care Center
Phone (US): 1-800-828-4040
(Available Mon. - Fri., 9 AM to 8 PM Eastern Time)

Canon Canada Inc.
Phone (Canada): 1-800-OK-CANON (1-800-652-2666)
(24 hours/day, 7 days/week)

EUROPE
Europe, Africa & Middle East

Canon Europa N.V.
PO Box 2262, 1180 EG Amstelveen, The Netherlands

Canon (UK) Ltd.
Helpdesk
Tel No.: 08705 143 723 (Calls may be recorded.)
Fax No.: 08705 143 340

Canon France S.A.
Hotline : 01.41.99.70.70
Tél :  01.41.99.77.77    Télécopie : 01.41.99.79.51

Canon Photo Vidéo France S.A.
Support Client: 01.41.30.15.18
Fax: 01.41.30.15.98

Canon Euro-Photo GmbH
Customer-Support: (02154) 495-482 or 483
Telefax: (02154) 495-489

Canon Italia S.p.A.
Pronto Canon : 02 8249 2000

Canon Belgium N.V. / S.A.
Helpdesk: 0900-10627
Tel.: (02) 722.04.11     Fax: (02) 721.32.74

Canon Luxembourg S.A.
Tel.: (352) 48 47 961     Fax: (352) 48 47 96232

Canon Nederland N.V.
Helpdesk: 023 - 5 681 681
Tel.: 023 - 5 670 123     Fax: 023 - 5 670 124

Canon Danmark A/S
Phone: +45 44882400
e-mail: helpdesk@canon.dk

Canon España S.A.
Help Desk: 906 301 255
Fax: (91) 411 76 65
E-mail: helpdesk1@btlink.net

Canon Norge as
Tlf. 22 62 93 21     Faks: 22 62 06 15
E-mail: helpdesk@canon.no

Finland
Canon OY
Puhelin: 010 54420     Fax: 010 544 4571
Help Desk: 0600 0 22606 (14,80 mk/min+pvm)
Help Desk: 0600 0 22666 (enint. 40mk/puhelu+pvm)
Sähköposti: helpdesk@canon.fi

Canon (Schweiz) AG
Tel. 01-835-6161,  Fax 01-835-6526
Hotline 0900 57 55 20

Canon Svenska AB
Stensätravägen 13, S-127 88, Skärholmen, Sweden

Austria
Canon GmbH
Oberlaaerstraße 233 A-1100 Vienna
Tel: 01 680 88-0     Fax: 01 680 88-308

OCEANIA
Canon Australia Pty. Ltd.
Info-Line: (02) 9805 2864

Canon New Zealand Ltd.
Info-Line: 0900-522666

ASIA
Canon Singapore Pte. Ltd.
79 Anson Road, #09-01 / 06, Singapore 079906
Phone: (65) 532 4400     Fax: (65) 221 7577

Canon Hongkong Co., Ltd.
9/F, The Hong Kong Club Building, 3A Chater Road,
Central, Hong Kong
Phone: 852-2739-0802     Fax: 852-2369-7701

Canon Marketing Services
No.1 Jalan Kilang Timor, #09-00, Pacific Tech Centre,
Singapore 159303
Phone: (65) 799 8888     Fax: (65) 273 3317

Canon Marketing (Malaysia) Sdn. Bhd.
Wisma General Lumber, Block D, Peremba Square,
Saujana Resort, Section U2, 40150,
Shah Alam, Selangor Darul Ehsan, Malaysia
Phone: (60) 3 744 6000, (60) 3 745 0055
Fax: (60) 3 745 0505

Canon Marketing (Thailand) Co., Ltd.
10th Floor, Bangkok City Tower,
179/34-45 South Sathorn Road,
Bangkok 10120, Thailand
Phone: (662) 344 9999      Fax: (662) 344 9910

Canon Marketing (Hongkong) Co., Ltd.
10/F, Mirror Tower, 61 Mody Road, Tsimshatsui East
Kowloon HongKong
Phone: 852-2170-2828      Fax: 852-2723-9684
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Adobe Customer Support
Adobe Systems Inc. technical support information is available in the PDF file format on
the supplied CD-ROM.

PDF File Location and Opening Instructions
Place the Adobe Photoshop LE CD-ROM in the drive and double-click the [My Computer]
icon on the Windows desktop, followed by the [Photosle] CD-ROM icon. The window will
show folders with language names. Double-click the appropriate language folder and the
[Support.pdf] file within it.

* To read PDF files, Adobe Acrobat Reader must already be installed on your computer. An
installer for this program is on the Adobe Photoshop LE CD-ROM within each language
folder in a folder labeled [Acroread].





Trademark Acknowledgments
• Canon, EOS and PowerShot are trademarks of Canon Inc.
• Adobe, Adobe PhotoDeluxe and Photoshop are trademarks of Adobe Systems Incorporated.
• CompactFlash is a trademark of SanDisk Corporation.
• IBM is a registered trademark of International Business Machines Corporation.
• iBook and iMac are trademarks of Apple Computer, Inc.
• Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of Apple Computer

Inc., registered in the United States and other countries.
• Microsoft, Windows and Windows NT are either registered trademarks or trademarks of

Microsoft Corporation in the United States and/or other countries.
• Other names and products not mentioned above may be registered trademarks or trademarks

of their respective companies.

Copyright © 2000 Canon Inc. All rights reserved.

Disclaimer
• While every effort has been made to ensure that the information contained in this guide is

accurate and complete, no liability can be accepted for any errors or omissions. Canon Inc.
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior written
permission of Canon Inc.

• Canon Inc. makes no warranties for damages resulting from corrupted or lost data due to
a mistaken operation or malfunction of the camera, the software, the CompactFlash™
cards (CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.
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